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1. ModelSim &l

ModelSim [& Mentor Graphics #th'SRIHENTND =2 U—HTY, YZa21U—FTHOHEH S,
EROMEZERE UCERT D ENTEFT, DEROEEZEFE UTCERRATSIET. REtLIZME
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Quartus Prime &3&&) U e ModelSim-Altera ZER LY S 20—y aveE

2. ModelSim D{ERRTE

ModelSim Z{ERTESD LI 7OV T I MERELEF L& S,
F . STEP 08-1 @ Quartus Prime 7OV 1 hERTEEY,

BREF O@DOWVWTFNHDFET Settings U« RUZEREEET,
@ Quartus Prime @ X=1—h'5 Assignment > Settings %R,
®@ Y—JUI\—D [Settings] My ~ #HUwvo,

@ Settings U« > R D Category #T EDA Tool Settings M Simulation %Z%&iR,
@ Toolname T ModelSim-Altera %5&iR,

® Format for output
O Time scale [V =

netlist #T Verilog HDL % 3%iR,
A=Y a VR BEETOSBEBRTY,. Y2 a—ya v THAILEWESDESI(C

ABOETHRELET, SEIFIOvI 50MHz T 1 A 20.0ns HDT 1ns BETLWVWTL &3,
@OKEIYUYILTU4Y RUZEBHALET,

7 Settings - Flip_Flop

Category:

General
Files.
Libraries

¥ IP Settings

Design Templates

Voltage

¥ Compiler Settings

VHDL Input

IP Catalog Search Locations

¥ Operating Settings

Tt Eormat for output ndistl Verilog HDL & \I (3) Tlmegtal.sl‘ ins lo
' Compilation Process Settings Output directory: | simulation/modelsim 11

Incremental Compilation O =
R Map illegal HOL characters Enable glitch filiering

Design Entry/Synthesis Options for Power Estimation

o [ Generate Value Char Dus (vCDj file scrij Script Setti
alue Change Dum, script  Script Seftings.
Board-Level = e e i Bt L

Specify options for generating output files for use with other EDA tools.

Tool name: lmddsinu\lm: ]D

[ Run gate-level simulati

and Conditions EDA Netlist Writer settings

Design instance name
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ab—3v

BEYIab—Yavik, BLUNICANDESZED ZNCHT IHAESZRALE T, COEEDLK
DHDANESDNY—VERRUCHDZET A MUYFEFUERT, TDTRMMYFONBEYITEITN
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@ File > New T [Verilog HDL File] Z&ATOK Z#T U w
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New Quartus Prime Project

“ Design Files
AHDL File
Block Diagram/Schematic File
EDIF File
Qsys System File
State Machine File
SystemVerilog HDL File
Tcl Script File

@ (Verilog HOL Fils )

VHDL File

¥ Memory Files
Hexadecimal (Intel-Format) File
Memary Initialization File

* Verification/Debugging Files
In-System Sources and Probes File

Logic Analyzer Interface File

‘D

A

Signal Tap Logic Analyzer File

uartus Prime Lite Edition - 10_nagaof t Quartus_verT »_Flop - Flip_Floj
Q Prime Lite Edi G/ 920/ D project Q p03/Fiip_Flop - Flip_Flop

File Edit View Project Assignments Processing Tools Window Help

D=sd D 7 C :|ripFlop A e S Mo S A DS
Project Navigator s Hierarchy. ~lags $ TestBench.v
s B | AR
Entity-instance B a7 = 9 3=

N Cyclone IV E: EP4CE22F17C6
EB Elip_Flop &

Tasks | Compilation ~|=[g®

Task
v P Compile Design
P Analysis & Synthesis
P Fitter (Place & Route)

P Assembler (Generate

P TimeQuest Timing Analysis
P EDA Netlist Writer
W Edit Settings

W Program Device (Open Frogrammer}

<
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TAMYFEERULTCVKHIIC, EABANESZEADNEZIFT. SO, ANESICRBUTOLS
BREDESZEERLE T,

-End Time (¥=aL—Y3VFE) : 100ns

- Time Scale (¥ alL—Y 3 VEtERRE) : 1ns

- CLK &% : 50MHz (20ns FA#A) oo0wv o

- RESET {§% : O ~ 60ns & Tl& High(1). 60 ~ 80ns »'Low(0). 80 ~ 100ns H' High(1)

- dfE%5 : 0~ 5ns H'Low(0). 5~ 15ns HHigh(1). 15ns ~ 35ns H'Low(0). 35 ~ 100ns H' High(1)

YZalb—YavEEZERL. Y2alb—YaVEitEERZElENK LIESDE. ModelSim H
IS—ZERIBED DD FT . RERBIGEICLTLEEL,

CORMEREZTRI EUTDRSICHEDFT,
CLK. RESET. d ® 3 DDESICL>T HAQAHEDKSICENLT DY ZaLb—Y 3T BDDTT,

o] 10 20 30 40 50 60 70 80 20 100 (ns)

CLK

RESET

CDRHEDT X "RV F % Verilog HDL T g D ERN—I DK S [CIED T T,
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o NCRREH]Y — A ECHELTVET. http://www.adwin.com/product/AKE-1104.html

| “timescale 1 ns/ 1 ns YT alb—vavon BRI / BE ZiEE.
BRI &I fs. ps. ns. us. ms. s BFIATES.

dule TestBench;
¢ modute festsench; FARRYFHEI1—VELTESET S, CCTCHEYLI—ILEE
TestBench & LMo TAMUFAHEY 2 —)UIFABSIESDERIEFE,

3
4 reg CLK, RESET, D; = 7Z hANESIE reg BET 3. |
5 wire Q; <[ F2 Ml wire BET 3. HAESEBAT2ZIEDT wire ST OKO]
6 step08-1.v TIERL LTcEY 21— Flip_Flop ZFEUH L. &#i%Z Test ELTWA. Y 2—)b Flip_Flop
[C52 BESEENTIETT 5. CCT523ESDIEER Flip_Flop Y 1—ILOESIBESTEBZ BT
2 & TODRITESREBELIFEN 260 THLL (& STEP14 TR
8 Flip_Flop Test(.CLK(CLK), .RESET(RESET), .D(D), .QCQ));
9 always ~ always XT—=OEDELENFERELTLS. |
10 #10 CLK = ~CLK; #10 LECIRT 5T & T 10ns 7Z2KRT (BAIFFE : Tns D))
10ns #BIC CLK §5%/KRE5. CNICK>T 20ns AAD I O v IIESEER.
11
initial initial Xl&. ¥ 20— 3 VRBRERICFUHINTETINDS.
12 tmtia initial XOEMICT Z MESDEIE %50k,
bea
o egn initial THEOHENE S, FTEES
, , , OYHERDRE, TOEE # BRUE
RESET = 1’ bl; CLK = 1’ b@; D = 1’ bo;
1 ; ; ; W ETTORREE Ons (RF— ) &
= —3 g UhEFE
. 45 D=1 bl; | LTYZalb—yauvhERTENs,
. 410D = 1’ b0 MEMERSE U SEEEEZ L REBD DT A MESRERT
’ BESTT B
. 420D = 1° bl: | | ESERBTDEEE (455 ;] LWSRTRR, TOL
’ FEBUBINEESEVON [# 5/ 25— M SORE
» 425 RESET = 1° bo; BRITIEE L, OEDRDMRNRITENTH SOBLRMIE L
WST &, DED #BEOAHYI 1L—Y 3 VEEEED.
19 #20 RESET = 17 bl; J
20 #20 $stop; $stop BV aL—YavOELERTHS.
5+10+20+25+20+20 = 100
21 end ZDFABRYFIF 100ns THT (B{IFFR @ 1ns Dfzs)
22

23 endmodule
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Quartus Prime & ModelSim-Altera EDEEIPYZ 2L —2 3V DcHDEEZLTVEXT,
@ Quartus Prime DX =a1—h'5 Tool > Options 2o U w7,
O X RENIZEE C EDA Tool Options ZEiR.
© Modelsim-Altera DEIRK S ~H'S modelsim.exe DRITT 7 1 L& 2 T + LY ZI8TE,

T 74 )L B TIlE C\intelFPGA _lite\17.1\modelsim_ase\win32aloem [C&H D F T,
OOKZIUYILTI1Y ROUZRAL D,

Ok Options X
Category:
¥ Genenl
(2] Specify the directory that contains the tool executable for each third-party EDA tool:
Fonts
Headers & Footers Settings EDA Tool Directory Containing Tool Executable {
¥ Internet Connectivity Precision Synth... .‘_._._.__i
Notifications synplify []
Libraries (|
v IpSettings Synplify Pro :l
IP Catalog Search Locations Active-HDL I
Design Templates Riviera-PRO [
License Setup e 'l
Preferred Text Editor =
Processing Questasim _]
Tooltip Settings ModelSim-Altera |C:\intelFPGA_lite\17.1\modelsim_ase\win32aloem 0 |
¥ Messages
Colors
Fonts
™ Text Editor
Colors
Fonts

Autocomplete Text

[ use NativeLink with a Synplify/Synplify Pro node-locked license

(4) OK | Cancel | . Help

ZCDEFREF Quartus Prime OFRELFD T, £70IJ 17 MMIRRENE T,
JOI 10 bTEICRET DREFSHDF A
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@ OD@DWVWIFNHDAET Settings 7« RUZRE.
@ Quartus Prime D X=a1—h'5 Assignment > Settings %Z3EiR,
@ W—)LI\—D [Settings] My «~ #HUwv,

0O FRENDERID Category ([CT EDA Tool Settings @ Simlation 27U w &,
© Tool name T ModelSim-Altera Z %R,

O NativeLink settings AIM Compile test bench ZF T v 7,

O Test Benches Z20U w2,

- Settings - Flip_Flop - ] ¥
Category: Device/Board...|
General
A Specify options for generating output files for use with other EDA tools.
Libraries

¥ IP Settings Tool name: | ModelSim-Altera 0 '

IP Catalog Search Locations
[ run gate-level simulation automatically after compilation

Design Templates

¥ Operating Settings and Conditions EDA Netlist Writer settings
Voltage -
Temperature FEormat for output netlist: _.Ven'loﬁ HDL '.. Time scale: |1ns '“
' Compilation Process Settings Output directory: |simulation/modelsim

Incremental Compilation

¥ EDA Tool Settings [ Map illegal HDL characters [ Enable glitch filtering

Design Entry/Synthesis Options for Power Estimation

@ [ Generate value Change Dump (VCD) file script | Script Settings...
Board-Level
¥ Compiler Settings Design instance name:
VHDL Input

Verilog HDL Input

More EDA Netlist Writer Settings...
Default Parameters ;

TimeQuest Timing Analyzer Nativelink settings

Assembler [ Vroe
Design Assistant

Signal Tap Logic Analyzer O(® compile test ben | =z

e Al ern e o [ use script to set up simulation:
Power Analyzer Settings
SSM Analyzer O Script to compile test bench:
| More Nativelink Settings... | Reset
| W Buy Software oK || cancel Apply Help

¥

RDNR—I N
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ONewZoUvo,

- Test Benches

Specify settings for each test bench.

Existing test bench settings: (10) l Mew... '

Name Top Level Module Design Instance Run For Test Bench File(s) Edit
Delete
| oK | | Cancel | | Help |

O RRENEDA 2 ROD Test bench name [CEFEERLUIET A MYFOEY 1 —)VREIEE.
SoDZE [TestBenchl,

® Test bench files D##ld File name @& o U w I L TEIFEER UTz [TestBench.v] ZER,

®Add Zo U w9 BE Test Benches U« RIIER LIET 7 1 ILDHFRREND,

@ 0K %5 Jwo LT New Test Bench Settings 7« > RUZEEU B,

= New Test Bench Settings had

Create new test bench settings.

Test bench name: [TestBench ]CD

Top level module in test bench: |TestBenr_h |

[[] uUse test bench to perform VHDL timing simulation
Design instance name in test bench: |NA
Simulation period
® Run simulation until all vector stimuli are used

O End simulation at: B

Test bench and simulation files

File name: | ® D[ Add ]@

File Mame Library HDL Version Remove
TestBench.wv Default
B Up
Down
Properties...

o o< )| concd || vep |
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®OKZ#IUwH LT Test Benchs U« RUZEHU %,

ab—3v

- Test Benches

Specify settings for each test bench.

Existing test bench settings:
Name Top Level Module  Design Instance Run For Test Bench File(s) Edit
TestBench TestBench NA TestBench.v
Delete
® l OK ] | Cancel | | Help

® More NativeLink Settings #oU v,

-/ Settings - Flip_Flop

Category:

General
Files
Libraries
¥ IP Settings
IP Catalog Search Locations
Design Templates
¥ Operating Settings and Conditions
Vaoltage
Temperature
¥ Compilation Process Settings
Incremental Compilation
¥ EDA Tool Settings
Design Entry/Synthesis
Simulation
Board-Level
¥ Compiler Settings
VHDL Input
Verilog HDL Input
Default Parameters
TimeQuest Timing Analyzer
Assembler
Design Assistant
Signal Tap Logic Analyzer
Logic Analyzer Interface
Power Analyzer Settings
SSN Analyzer

Simulation

Specify options for generating output files for use with other EDA tools.

I
Tool name: | ModelSim-Altera

[ run gate-level simulation automatically after compilation

EDA Metlist Writer settings

Format for output netlist: l\l'erilog HDL

'I Time scale: |1ns

Output directory: |simu|.a€\on,fmudelsim

O Map illegal HDL characters

Options for Power Estimation
[] Generate Value Change Dump (VCD) file script

Design instance name

|More EDA Netlist Writer Settings

MativeLink settings

O MNone

[ enable glitch filtering

Script Settings...

® Compile test bench: | TestBench

1
X | |Tesl Benches...

O Use script to set up simulation:

O Script to compile test bench:

| W Buy Software | ‘ OK | i Cancel | ‘ Apply | | Help
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® Location of user compiled simulation library 170D Setting @--- &2 Uw o LT T # LY %&ER,
7OV U T #)LFHED \simulation\modelsim 7 # LY Z1ExE.
B U simulation 7 # LY DYER SN TLEWLES, —E Settings ZBAU T VI ILZE(TD,

® OK #2U w2 LT More NativelLink Settings D« > ROZFU %,

- More NativelLink Settings

Specify the settings for the NativeLink options in your project.

| & <<Fitter>> Show: | Al -|
MName: Setting:

Additional custom simulation elaboration options =

Enable Simulation with hw.tcl based IP cores On

Generate third- party EDA tool command scripts without running the EDA tool | Off

Launch third-party EDA tool in command-line mode oOff

Location of user compiled simulation library

P e

Er‘l?\stepﬂ&\simulation\modelsiml...] @
"Ne—

Write out portable file paths in third-party EDA tool command scripts off

Description:

Specify the directory where you store the library generated with the EDA Simulation Library Compiler

tool. Note: Do not use this option to specify the directory for ModelSim-Altera precompiled libraries or |ﬂ|
Active-HDL precom piled libraries.

® [l OK ] I Cancel | | Help |

®OKZIYUwH LT Settings U« ROZBKU S,
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3V DRT

QYVZaL—vavoRENTETURSBEIVINAILEITLET,
@ Quartus Prime D XZ=a1—hH'5 Tools > Run Simulation Tools > RTL Simlation Z&EiR,
g D& ModelSim-Altera BiZI5HHD LIFSHLKTBHEVZTaL—Ya VD RTULED,

(3 Quartus Prime Lite Edition - Ci/Users/win10_nagao/Documents/project Quartus verl7/step03/Flip_Flop - Flip_Flop - u] X

File Edit View Project Assignments Processing Tools Window Help

Of=H D02 C ke | S TrFES @L0H
Project Navigator | 1 Hierarchy ~afge <| ¢ TestBench.v B ¢ Step08-1.v [ & compilation Report - Flip_Flop )
Ei S Table of Contents &84 Flow Summary
M Cyclone IV E: EPACEZ2F17C6 B8 Flow Summary M sehiieios
EE rjp Flop & EE Flow Settings Flow Status Successful - Thu Mar 29 14:00:52 2018
EE Flow Mon-Default Global Settings Quartus Prime Version 17.1.0 Build 530 10/25/2017 SJ Lite Edition
ER Flow Elapsed Time Revision Name Flip_Flop
ER Flow 0S Summary Top-level Entity Name Flip_Flop
El Flow Log Family Cyclone IV E
= 3| 7 M8 Analysis & Synthesis Device EP4CE22F17C6
= > M Fitter Timing Models Final
Tasks | Comipilation T | SHS *
P! | > [ Assembler Total logic elements 1/22320(<1%)
Task > M TimeQuest Timing Analyzer Total registers 1
« |~ P Compile Design > [ EDA Netlist Writer Total pins 4/154(3%)
> B Analysis & Synthesis © Flow Messages Total virtual pins 0
5 s R s O Flow Suppressed Messages Total memory bits 0/608,256(0%)
Embedded Multiplier 9-bit elements 0/ 132 (0 %)
v > P Assembler (Generate programming|
Total PLLs 0/4(0%)
L4 > P TimeQuest Timing Analysis
v > P EDA Netlist Writer
B cditsettings
& Program Device (Open Programmer)
< > < >
x T — T :
g | aw adl “7’ <<Filters> | 88 Eind.. | 88 Find Next|
iy

Type ID  Message

e

System  Processing

0% 100:00:00
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O Wave 770Uy IgdE. B CYIaL—Ya VERETER T,

@ Zoom Fill @ FEEE> TRRYA XEREL. REERRBLET .
O Restart Ef Z22U v/ LTYZab—ya Y UILEBZEASL | 100 ps 4|, RunEL THLED

FKTIDIEDHTEET,

™ ModelSim - INTEL FPGA STARTER EDITION 10.5b 9 — a X
File Edit View Compile Simulate Add Wave Tools Layout Bookmarks Window Help
|t ] w-Juprms yos]tatiz-an

B8 & iRBOC| AT N|STRAN
_Eﬁgy B

ss-a-g& QIJI_I_TI—, g

Layout [simulate - ‘ ColumnLayout [Defaulc

dEE e |J oo - e | Search: ol i “ @ U
;@mm-nefamt— —— H @ %] ﬁomens JJJ\ izl >
#|Instance [Designunit | | [

J-,‘ TestBench TestBench

&l Test Fiip_Flop
‘ FALWAYS#9 TestBench
& FNITIAL#12  Testbench |

| #vsim_capadty#

| | »
s— g x|
Type (fitered)

& Processes (Active) —

1 2ALWAYS 9

100 ns

0.00 ns J [o-00 ns]

Cursor 1 |

s [

[ [T

| »

|

<

i torary | Esm

§=) Transcript

§ *+ Note: §stop C:/Users/winl)_nagac/DocuUments/project_QUartus verl?/step0d/TestBench.v(20) |
19/TestBench.v line 20

# Time: 100 ns Iteration: 0 Instance: /TestBench

# Break in Module TestBench at C:/Users/winl0_nagao/Documents/project_Quartus_werl7/step09

just™ 2>
Opsto 105ns y

| restgenchicik

[Now: 100ns Delta: 0

s

VZ 2= aVHhERFINBEVES

ModelSim E&E <&k

FTFRARMIUFHE UL (FEER ‘Tbklﬁlﬁﬁkﬂbb‘@?ﬁmﬁb‘ﬁ hFxET,
% Transcript [CTS—X v E—IDBHTULEWLHEESRL TL S

FE08-2 BAKKICYZaL—Y3aVUTHFL& D,
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VZab—YaVORRERTCHDE OANDZ1ICTHE O CLKDILE ENDTHII Q DIE 1(S7ED
F9. OFZDBANDHOICHESOTHHAQIF 1 DEXTT, O CLK HBULE EHDEHAIQIFOIICHED
F9. COE. QT HREFEINTVLE LI,

RESET S5 DENEZEFET HIcHHEN QDEZ 1 [CLET. (BANDZ1(CTHE OCLKDIIBLENDT
HH QOMEETICEDEY) OZDEE RESET ESHII5TH2E QDIED O [LE2TVSDHINDET,

4. [TestBench/dk
4. [TestBench/reset
4. [TestBench/d

4. [TestBench/g

Cursor 1

b [TestBench/dk

"+ [TestBench/reset
f. [TestBench/d

" [TestBench/q

Cursor 1

—R. AU Y FEERICEAFTITH. RESETESHG ofc EEDEECEVD GO XY, EKIF L
RESET E8hi% o fcERIC Q DEN O [CED X ULcH. SEIF RESET ESHANENTH Q DfEIL O [
F5T. RICCLKMIIB EhofcEE Q DEH O [CE>TVIET,

U Y hTIE. B Q OEEDR T CLK DIIE END TERIDET, DFD. BN TR THE1D
DoOy I TINCOLEEHEENT DDTY, 7% EEEHREE ELWXT,
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EHALEE(E ./ 1 X (C580L) ?

BN T, ADESIC/AZXDEfcELTE. /A ADIAZVINIOYvIDIAIVTE—HL
FIFNSREMECIEED T B A, ReFI/OvIDTAIVTE—H U/ A XEIFH. REMEICDIF

HbFEY,
EIHATC NG 5
H H H H CLK FF —a
—— reseT
FEHEX NG NG NG 5
H H H H CLK FF —a
—— I FESET

SEIDHIT RESET E5(C/ A A& > CLFE ofciza. JEEHY By MEIEREMEL TRIFL TLBIED
BFICUEY hENTLEVLET., L L. BRYEY MFZOYIESDOIYAIVIIC/ A XH—HL
VR D ERENE LIEL e, FERFARSICLENT ./ 1 X(CBNENR T,

ULHL. AEEOTRTICBVTENTVNDEVNSRTIESDFEA, BHRN. FFRABAXZNZNAY v
FFXUw hHH D, BEEFIEPERSNDARRICL O TERI DNENDDH T,

FEEHAC

B — N COEER—EHERELTL

[EIHAC
A ZVIHEDBES.
XUw bk N R
B/ A XT38
. ERTNZEEFEDEALT .
TAUw

HEBRNKRELLED.

FTAUy [ LTeth, DEFIENAELBD LY
AIVIREDHLLED
EMENDEEEFRDNE <D

AUy

HEEERD—ARIC/NEL.
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